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About this manual 
 

This manual describes the System 200V CANopen master IM 208-1CA00 
from VIPA. Here you may find every information for commissioning and 
operation. 
 

Chapter 1: Basics and Assembly 
The focus of this chapter is on the introduction of the VIPA System 200V. 
Here you will find the information required to assemble and wire a 
controller system consisting of System 200V components. 
Besides the dimensions the general technical data of System 200V will be 
found.   
 
Chapter 2: Hardware description  
Here the hardware components of the IM 208-1CA00 are described. The 
technical data are at the end of the chapter. 
 
Chapter 3: Deployment IM 208CAN 
This chapter contains the description of the VIPA CANopen master 
module. Another section of this chapter concerns the project engineering 
for "experts" and an explanation of the telegram structure and the function 
codes of CANopen.  
The description of the Emergency Object and NMT conclude the chapter. 
 

Overview 
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This manual describes the System 200V CANopen master IM 208-1CA00 
from VIPA. It contains a description of the construction, project 
implementation and usage. 
This manual is part of the documentation package with order number  
HB97E_IM and relevant for:  
Product Order number as of state: 
  HW 
IM 208CAN VIPA 208-1CA00 01 
 

The manual is targeted at users who have a background in automation 
technology. 
 

The manual consists of chapters. Every chapter provides a self-contained 
description of a specific topic. 
 

The following guides are available in the manual: 
• an overall table of contents at the beginning of the manual 
• an overview of the topics for every chapter 
 

The manual is available in: 
• printed form, on paper 
• in electronic form as PDF-file (Adobe Acrobat Reader) 
 

Important passages in the text are highlighted by following icons and 
headings: 
 

Danger! 
Immediate or likely danger. 
Personal injury is possible. 
 

Attention! 
Damages to property is likely if these warnings are not heeded. 
 

Note! 
Supplementary information and useful tips. 

 

Objective and 
contents 

Target audience 

Structure of the 
manual 

Guide to the 
document 

Availability 

Icons 
Headings 
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Safety information 
 

The IM 208CAN is constructed and produced for: 
• all VIPA System 200V components 
• communication and process control 
• general control and automation applications 
• industrial applications 
• operation within the environmental conditions specified in the technical 

data 
• installation into a cubicle 
 

Danger! 
This device is not certified for applications in 
• in explosive environments (EX-zone) 
 

The manual must be available to all personnel in the 
• project design department 
• installation department 
• commissioning 
• operation 
 

The following conditions must be met before using or commissioning 
the components described in this manual: 
 
• Hardware modifications to the process control system should only be 

carried out when the system has been disconnected from power! 
 
• Installation and hardware modification only by properly trained 

personnel. 
 
• The national rules and regulations of the respective country must be 

satisfied (installation, safety, EMC ...) 
 

National rules and regulations apply to the disposal of the unit! 
 

Applications 
conforming with 
specifications 

 

Documentation 

 

Disposal 
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Chapter 1 Basics and Assembly 
 

The focus of this chapter is on the introduction of the VIPA System 200V. 
Here you will find the information required to assemble and wire a controller 
system consisting of System 200V components. 
Besides the dimensions the general technical data of System 200V will be 
found.   
 

 

Topic     Page 
Chapter 1 Basics and Assembly ..................................................... 1-1 

Safety Information for Users................................................................. 1-2 
System conception ............................................................................... 1-3 
Dimensions .......................................................................................... 1-5 
Installation............................................................................................ 1-7 
Demounting and module exchange .................................................... 1-11 
Wiring................................................................................................. 1-12 
Installation guidelines ......................................................................... 1-14 
General data ...................................................................................... 1-17 

 

 

Overview 

Contents 
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Safety Information for Users 
 

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages 
that can occur during electrostatic discharges. 
The following symbol is attached to modules that can be destroyed by 
electrostatic discharges. 
 

 
 
The Symbol is located on the module, the module rack or on packing 
material and it indicates the presence of electrostatic sensitive equipment. 
It is possible that electrostatic sensitive equipment is destroyed by energies 
and voltages that are far less than the human threshold of perception. 
These voltages can occur where persons do not discharge themselves 
before handling electrostatic sensitive modules and they can damage 
components thereby, causing the module to become inoperable or 
unusable. 
Modules that have been damaged by electrostatic discharges can fail after 
a temperature change, mechanical shock or changes in the electrical load. 
Only the consequent implementation of protection devices and meticulous 
attention to the applicable rules and regulations for handling the respective 
equipment can prevent failures of electrostatic sensitive modules. 
 

Modules must be shipped in the original packing material. 
 

 
When you are conducting measurements on electrostatic sensitive modules 
you should take the following precautions: 
• Floating instruments must be discharged before use. 
• Instruments must be grounded. 
Modifying electrostatic sensitive modules you should only use soldering 
irons with grounded tips. 
 

Attention! 
Personnel and instruments should be grounded when working on 
electrostatic sensitive modules. 
 
 

Handling of 
electrostatic 
sensitive modules 

Shipping of 
electrostatic 
sensitive modules 

Measurements and 
alterations on 
electrostatic 
sensitive modules 
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System conception 
 

The System 200V is a modular automation system for assembly on a 
35mm profile rail. By means of the peripheral modules with 4, 8 and 16 
channels this system may properly be adapted matching to your 
automation tasks. 
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The System 200V consists of the following components: 
• Head modules like CPU and bus coupler 
• Periphery modules like I/O, function und communication modules 
• Power supplies  
• Extension modules 
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With a head module CPU respectively bus 
interface and DC 24V power supply are 
integrated to one casing. 
Via the integrated power supply the CPU 
respectively bus interface is power 
supplied as well as the electronic of the 
connected periphery modules. 
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The modules are direct installed on a 
35mm profile rail and connected to the 
head module by a bus connector, which 
was mounted on the profile rail before. 
Most of the periphery modules are 
equipped with a 10pin respectively 18pin 
connector. This connector provides the 
electrical interface for the signaling and 
supplies lines of the modules. 
 

Overview 

Components 

Head modules 

Periphery modules 
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With the System 200V the DC 24V power 
supply can take place either externally or 
via a particularly for this developed power 
supply. 
The power supply may be mounted on the 
profile rail together with the System 200V 
modules. It has no connector to the back-
plane bus. 
 

 

CM 201
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X 2
3 4
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The expansion modules are complemen-
tary modules providing 2- or 3wire con-
nection facilities.  
The modules are not connected to the 
backplane bus. 
 

 

• Profile rail 35mm  
• Dimensions of the basic enclosure: 
 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3 
 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3 
 

Please note that you can only install head modules, like the CPU, the PC 
and couplers at slot 1 or 1 and 2 (for double width modules). 
 

[1] Head module 
(double width) 

[2] Head module  
(single width)  

[3] Periphery module 
[4] Guide rails 

1 2

4

3

0 1

Clack

D
P

 

 
Note 
Information about the max. 
number of pluggable modules 
and the max. current at the 
backplane bus can be found in 
the "Technical Data" of the 
according head module. 
Please install modules with a 
high current consumption direct-
ly beside the head module.  
 

 

Power supplies 

Expansion 
modules 

Structure/ 
dimensions 

Installation 
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Dimensions 
 

1tier width (HxWxD) in mm: 76 x 25.4 x 74 
2tier width (HxWxD) in mm: 76 x 50.8 x 74 
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Dimensions 
Basic enclosure 

Installation 
dimensions 

Installed and wired 
dimensions 
In- / Output 
modules 
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Function modules/ 
Extension modules 

CPUs (here with 
EasyConn from 
VIPA) 
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Installation 
 

The modules are each installed on a 35mm profile rail and connected via a 
bus connector. Before installing the module the bus connector is to be 
placed on the profile rail before. 
 

For installation the following 35mm profile rails may be used: 
 

35 mm

27 mm
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 m

m

1,
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m
m

35 mm

27 mm

7,
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m
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m
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Order number Label Description 
290-1AF00 35mm profile rail Length 2000mm, height 15mm
290-1AF30 35mm profile rail Length 530mm, height 15mm 
 

System 200V modules communicate via a backplane bus connector. The 
backplane bus connector is isolated and available from VIPA in of 1-, 2-, 4- 
or 8tier width. 
The following figure shows a 1tier connector and a 4tier connector bus: 
 

 
 
The bus connector is to be placed on the profile rail until it clips in its place 
and the bus connections look out from the profile rail. 
Order number Label Description 
290-0AA10 Bus connector 1tier 
290-0AA20 Bus connector 2tier 
290-0AA40 Bus connector 4tier 
290-0AA80 Bus connector 8tier 

                           
 

General 

Profile rail 

Bus connector 
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The following figure shows the installation of a 4tier width bus connector in 
a profile rail and the slots for the modules.  
The different slots are defined by guide rails.  
 

[1] Head module  
(double width) 

[2] Head module  
(single width) 

[3] Peripheral module 
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[4] Guide rails 

       

• Use bus connectors as long as possible. 
• Sort the modules with a high current consumption right beside the head 

module. In the service area of www.vipa.com a list of current 
consumption of every System 200V module can be found. 

 

Installation on a 
profile rail  

Assembly regarding 
the current 
consumption 
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hoizontal assembly

lying assembly

vertical
assembly

0 1

0
1

Please regard the allowed environmental temperatures: 

• horizontal assembly: from 0 to 60°C 
• vertical assembly: from 0 to 40°C 
• lying assembly: from 0 to 40°C 
 
The horizontal assembly always starts at the left side with 
a head module, then you install the peripheral modules 
beside to the right.  
You may install up to 32 peripheral modules.  
 
 
 

80
 m

m
60

 m
m

 

Please follow these rules during the assembly! 
• Turn off the power supply before you install or remove 

any modules!  
• Make sure that a clearance of at least 60mm exists 

above and 80mm below the middle of the profile rail. 
 

 
 

 

• Every row must be completed from left to right and it 
has to start with a head module. 

 
[1] Head module (double width) 
[2] Head module (single width) 

1 2

4

3

 [3] Peripheral modules 
 [4] Guide rails 

 
 • Modules are to be installed side by side. Gaps are not 

permitted between the modules since this would 
interrupt the backplane bus. 

• A module is only installed properly and connected 
electrically when it has clicked into place with an 
audible click. 

• Slots after the last module may remain unoccupied.  
 
Note! 
Information about the max. number of pluggable modules and the max. 
current at the backplane bus can be found in the "Technical Data" of the 
according head module. 
Please install modules with a high current consumption directly beside the 
head module.  

Assembly 
possibilities 
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• Install the profile rail. Make sure that a clearance of at least 60mm 
exists above and 80mm below the middle of the profile rail. 

 
 
 
 
 
 
• Press the bus connector into the profile rail until it clips securely into 

place and the bus-connectors look out from the profile rail. This 
provides the basis for the installation of your modules. 

 
 
 
 
• Start at the outer left location with the installation of your head module 

and install the peripheral modules to the right of this. 
[1] Head module  

(double width) 
[2] Head module 

(single width) 
[3] Peripheral module 

1 2

4

3

[4] Guide rails 

• Insert the module that you are installing into the profile rail at an angle 
of 45 degrees from the top and rotate the module into place until it 
clicks into the profile rail with an audible click. The proper connection 
to the backplane bus can only be guaranteed when the module has 
properly clicked into place. 

Clack  

 

Attention! 
Power must be turned off before modules are 
installed or removed! 
 

 
 

Assembly 
procedure 
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Demounting and module exchange 
 

1

2

3

4

5

 
 
 

 
 

• Remove if exists the wiring to the module, by pressing both 
locking lever on the connector and pulling the connector. 

 
   
 
 
• The casing of the module has a spring loaded clip at the 

bottom by which the module can be removed. 
 
 
 

 
 
• The clip is unlocked by pressing the screwdriver in an upward 

direction. 
 
 
 
 
 
• Withdraw the module with a slight rotation to the top. 
 
 
 
 
 
 
 
 
 
 
 
 
Attention! 
Power must be turned off before modules are installed or 
removed! 
Please regard that the backplane bus is interrupted at the point 
where the module was removed! 
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Wiring 
 

Most peripheral modules are equipped with a 10pole or a 18pole connector. 
This connector provides the electrical interface for the signaling and supply 
lines of the modules. 
The modules carry spring-clip connectors for interconnections and wiring. 
The spring-clip connector technology simplifies the wiring requirements for 
signaling and power cables.  
In contrast to screw terminal connections, spring-clip wiring is vibration 
proof. The assignment of the terminals is contained in the description of the 
respective modules. 
You may connect conductors with a diameter from 0.08mm2 up to 2.5mm2 
(max. 1.5mm2 for 18pole connectors). 
The following figure shows a module with a 10pole connector. 
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[1] 
[2] 
[3] 
[4] 
[5] 

Locking lever 
Pin no. at the module 
Pin no. at the connector 
Wiring port 
Opening for screwdriver 
 

 

Note! 
The spring-clip is destroyed if you push the screwdriver into the wire port!  
Make sure that you only insert the screwdriver into the square hole of the 
connector! 
 

Overview 
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• Install the connector on the module until it locks with an audible click. 
For this purpose you press the two clips together as shown. 
The connector is now in a permanent position and can easily be wired. 

 
 
The following section shows the wiring procedure from top view. 
 

 

• Insert a screwdriver at an angel into the square opening as shown. 
• Press and hold the screwdriver in the opposite direction to open the 

contact spring. 
 
 
 
 
 
• Insert the stripped end of the wire into the round opening. You can use 

wires with a diameter of 0.08mm2 to 2.5mm2  
(1.5mm2 for 18pole connectors). 

 
 
 
 
 
 
 
• By removing the screwdriver the wire is connected safely with the plug 

connector via a spring. 
 

 

Note! 
Wire the power supply connections first followed by the signal cables 
(inputs and outputs). 
 
 

Wiring procedure 
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Installation guidelines 
 

The installation guidelines contain information about the interference free 
deployment of System 200V systems. There is the description of the ways, 
interference may occur in your control, how you can make sure the 
electromagnetic digestibility (EMC), and how you manage the isolation. 
 

Electromagnetic digestibility (EMC) means the ability of an electrical device, 
to function error free in an electromagnetic environment without being 
interferenced res. without interferencing the environment. 
All System 200V components are developed for the deployment in hard 
industrial environments and fulfill high demands on the EMC. Nevertheless 
you should project an EMC planning before installing the components and 
take conceivable interference causes into account. 
 

Electromagnetic interferences may interfere your control via different ways: 
• Fields 
• I/O signal conductors 
• Bus system 
• Current supply 
• Protected earth conductor 
 
Depending on the spreading medium (lead bound or lead free) and the 
distance to the interference cause, interferences to your control occur by 
means of different coupling mechanisms. 
One differs: 
• galvanic coupling 
• capacitive coupling 
• inductive coupling 
• radiant coupling 

 
 

General 

What means EMC? 

Possible 
interference 
causes 
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In the most times it is enough to take care of some elementary rules to 
guarantee the EMC. Please regard the following basic rules when installing 
your PLC. 
• Take care of a correct area-wide grounding of the inactive metal parts 

when installing your components. 
- Install a central connection between the ground and the protected 

earth conductor system. 
- Connect all inactive metal extensive and impedance-low. 
- Please try not to use aluminum parts. Aluminum is easily oxidizing 

and is therefore less suitable for grounding. 
• When cabling, take care of the correct line routing. 

- Organize your cabling in line groups (high voltage, current supply, 
signal and data lines). 

- Always lay your high voltage lines and signal res. data lines in 
separate channels or bundles. 

- Route the signal and data lines as near as possible beside ground 
areas (e.g. suspension bars, metal rails, tin cabinet). 

• Proof the correct fixing of the lead isolation. 
- Data lines must be laid isolated. 
- Analog lines must be laid isolated. When transmitting signals with 

small amplitudes the one sided laying of the isolation may be 
favorable. 

- Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with 
cable clamps. 

- Make sure that the isolation/protected earth conductor rail is 
connected impedance-low with the cabinet. 

- Use metallic or metalized plug cases for isolated data lines. 
• In special use cases you should appoint special EMC actions. 

- Wire all inductivities with erase links. 
- Please consider luminescent lamps can influence signal lines. 

• Create a homogeneous reference potential and ground all electrical 
operating supplies when possible. 
- Please take care for the targeted employment of the grounding 

actions. The grounding of the PLC is a protection and functionality 
activity. 

- Connect installation parts and cabinets with the System 200V in star 
topology with the isolation/protected earth conductor system. So you 
avoid ground loops. 

- If potential differences between installation parts and cabinets occur, 
lay sufficiently dimensioned potential compensation lines. 

Basic rules for 
EMC 



Chapter 1   Basics and Assembly Manual VIPA System 200V 

1-16  HB97E - IM - RE_208-1CA00 - Rev. 15/14 

Electrical, magnetically and electromagnetic interference fields are 
weakened by means of an isolation, one talks of absorption. 
Via the isolation rail, that is connected conductive with the rack, 
interference currents are shunt via cable isolation to the ground. Hereby 
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may 
appear as interference cause. 
 
When isolating cables you have to regard the following: 
• If possible, use only cables with isolation tangle. 
• The hiding power of the isolation should be higher than 80%. 
• Normally you should always lay the isolation of cables on both sides. 

Only by means of the both-sided connection of the isolation you achieve 
high quality interference suppression in the higher frequency area. 
Only as exception you may also lay the isolation one-sided. Then you 
only achieve the absorption of the lower frequencies. A one-sided 
isolation connection may be convenient, if: 
- the conduction of a potential compensating line is not possible 
- analog signals (some mV res. µA) are transferred 
- foil isolations (static isolations) are used. 

• With data lines always use metallic or metalized plugs for serial 
couplings. Fix the isolation of the data line at the plug rack. Do not lay 
the isolation on the PIN 1 of the plug bar! 

• At stationary operation it is convenient to strip the insulated cable 
interruption free and lay it on the isolation/protected earth conductor line. 

• To fix the isolation tangles use cable clamps out of metal. The clamps 
must clasp the isolation extensively and have well contact. 

• Lay the isolation on an isolation rail directly after the entry of the cable in 
the cabinet. Lead the isolation further on to the System 200V module 
and don't lay it on there again! 

 

Please regard at installation! 
At potential differences between the grounding points, there may be a 
compensation current via the isolation connected at both sides. 
Remedy: Potential compensation line. 
 

 
 

Isolation of 
conductors 
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General data 
 

• Profile rail 35mm  
• Peripheral modules with recessed labelling 
• Dimensions of the basic enclosure: 
 1tier width: (HxWxD) in mm: 76x25.4x74 in inches: 3x1x3 
 2tier width: (HxWxD) in mm: 76x50.8x74 in inches: 3x2x3 
 

• Wiring by means of spring pressure connections (CageClamps) at the 
front-facing connector, core cross-section 0.08 ... 2.5mm2 or 1.5mm2 
(18pole plug) 

• Complete isolation of the wiring when modules are exchanged 
• Every module is isolated from the backplane bus 

Structure/ 
dimensions 

Reliability 
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Conformity and approval 
Conformity 
CE 2006/95/EC Low-voltage directive 
 2004/108/EC EMC directive 
Approval 
UL UL 508 Approval for USA and Canada 
others 
RoHS 2011/65/EU Product is lead-free; Restriction of the use of 

certain hazardous substances in electrical and 
electronic equipment 

 

Protection of persons and device protection 
Type of protection - IP20 
Electrical isolation 
to the field bus - electrically isolated 
to the process level - electrically isolated 
Insulation resistance EN 61131-2 - 
Insulation voltage to reference earth 
Inputs / outputs - AC / DC 50V, test voltage AC 500V 
Protective measures - against short circuit 

 

Environmental conditions to EN 61131-2 
Climatic 
Storage / transport EN 60068-2-14 -25…+70°C 
Operation 
Horizontal installation EN 61131-2 0…+60°C 
Vertical installation EN 61131-2 0…+60°C 
Air humidity EN 60068-2-30 RH1 (without condensation, rel. humidity 10…95%)
Pollution EN 61131-2 Degree of pollution 2 
Mechanical 
Oscillation EN 60068-2-6 1g, 9Hz ... 150Hz 
Shock EN 60068-2-27 15g, 11ms 

 

Mounting conditions 
Mounting place - In the control cabinet 
Mounting position - Horizontal and vertical 

 

EMC Standard Comment 
Emitted 
interference 

EN 61000-6-4 Class A (Industrial area) 

EN 61000-6-2   Industrial area 

EN 61000-4-2 ESD 
8kV at air discharge (degree of severity 3), 
4kV at contact discharge (degree of severity 2) 

EN 61000-4-3 HF field immunity (casing) 
80MHz … 1000MHz, 10V/m, 80% AM (1kHz) 
1.4GHz ... 2.0GHz, 3V/m, 80% AM (1kHz) 
2GHz ... 2.7GHz, 1V/m, 80% AM (1kHz) 

EN 61000-4-6 HF conducted  
150kHz … 80MHz, 10V, 80% AM (1kHz) 

EN 61000-4-4 Burst, degree of severity 3 

Noise immunity 
zone B  

EN 61000-4-5 Surge, installation class 3 *) 
*) Due to the high-energetic single pulses with Surge an appropriate external protective circuit with 

lightning protection elements like conductors for lightning and overvoltage is necessary. 
 
 

General data 
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Chapter 2  Hardware description 
 

Here the hardware components of the IM 208-1CA00 described.  
The technical data are at the end of the chapter. 
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Properties 
 

• 125 CAN slaves can be connected to one CANopen master 
• Project engineering under WinCoCT from VIPA 
• Diagnosis ability 
• 40 Transmit PDOs 
• 40 Receive PDOs 
• PDO-Linking 
• PDO-Mapping 
• 1 SDO as Server, 127 SDO as Client 
• Emergency Object 
• NMT Object 
• Node Guarding, Heartbeat 
• In-/output range 0x6xxx each max. 64Bytes 
• In-/output range 0xAxxx each max. 320Bytes 
 

IM 208 CAN

C
A
N

RN

ER

IF

BA

VIPA 208-1CA00

X 2
3 4

 
 

Type Order number Description 
IM 208CAN VIPA 208-1CA00 CAN-Bus CANopen master 

1MBaud, up to 125 slaves  
 
 

IM 208CAN 
208-1CA00 

Order data 
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Structure 
 

[1] LED status indicators 
[2] CAN-Bus socket 

  
  
  

 

2

1

IM 208 CAN

RN

ER

IF

BA

VIPA 208-1CA00

X 2
3 4

C
A
N

 

  

 

The VIPA CAN-Bus master is connected to the CAN-Bus system by means 
of a 9pin plug. 
The following diagram shows the pin assignment for the interface: 
 

1

2

3

4

5

6

7

8

9

CAN

n. c.
CAN low
CAN Ground
n. c.
shield
optional Ground
CAN high
n. c.
n. c.

1

2

3

4

5

6

7

8

9  

Master Slave

CAN high

CAN Ground

Shield

Shield

CAN low

CAN Ground

CAN high

Do not connect

120Ω

7

2

3

120Ω
CAN low

 

Note! 
The end of the bus cable must be terminated with a 120Ω terminating 
resistor to prevent reflections and the associated communication errors! 
 

Front view  
IM 208CAN 

CAN interface 
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The CANopen master module is equipped with LEDs for diagnostic 
purposes. The following table shows how the diagnostic LEDs are used 
along with the respective colors. 
 
Name Color Description 

RN green ON: CPU is in RUN 
OFF: CPU is in STOP 

ER red ON: During initialization and at slave failure 
OFF: All slaves are in the state "operational" 

BA yellow BA (Bus active) shows communication via CAN bus 
ON: state "operational" 
Blinks with 1Hz: shows state "pre-operational" 
Blinks with 10Hz: shows state "prepared" 

IF red ON: "Initialisierungsfehler" (i.e. initialization error) at 
wrong parameterization 
OFF: Initialization is OK 

 

Note! 
All the LEDs flash at 1Hz, expects the CAN master valid parameters from 
the CPU. Gets the CAN master no parameters from the CPU, after 5sec all 
LEDs are off. 
 
 

 

The CANopen master receives the voltage supply via the backplane bus. 
 

LEDs 

     

Power supply 
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Technical data 
 

Order no. 208-1CA00 
Type IM 208CAN, CANopen 

master 
Current consumption/power loss  
Current consumption from backplane bus 300 mA 
Power loss 1.5 W 
Status information, alarms, diagnostics  
Status display yes 
Interrupts yes, parameterizable 
Process alarm no 
Diagnostic interrupt yes, parameterizable 
Diagnostic functions yes 
Diagnostics information read-out possible 
Supply voltage display none 
Group error display red LED 
Channel error display none 
Functionality Sub-D interfaces  
Type - 
Type of interface CAN 
Connector Sub-D, 9-pin, male 
Electrically isolated  
MPI - 
MP²I (MPI/RS232) - 
Point-to-point interface - 
Housing  
Material PPE 
Mounting Profile rail 35 mm 
Mechanical data  
Dimensions (WxHxD) 25.4 x 76 x 78 mm 
Weight 80 g 
Environmental conditions  
Operating temperature 0 °C to 60 °C 
Storage temperature -25 °C to 70 °C 
Certifications  
UL508 certification yes 
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Chapter 3  Deployment IM 208CAN 
 

This chapter contains the description of the VIPA CANopen master module. 
Another section of this chapter concerns the project engineering for 
"experts" and an explanation of the telegram structure and the function 
codes of CANopen.  
The description of the Emergency Object and NMT conclude the chapter. 
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Basics CANopen 
 

CANopen (Control Area Network) is an international standard for open 
fieldbus systems intended for building, manufacturing and process 
automation applications that was originally designed for automotive 
applications. 
Due to its extensive error detection facilities, the CAN-Bus system is 
regarded as the most secure bus system. It has a residual error probability 
of less than 4.7x10-11. Bad messages are flagged and retransmitted 
automatically.  
In contrast to PROFIBUS and Interbus, CAN defines under the CAL-level-
7-protocol (CAL=CAN application layer) defines various level-7 user 
profiles for the CAN-Bus. One standard user profile defined by the CIA 
(CAN in Automation) e.V. is CANopen.  
 

CANopen is a user profile for industrial real-time systems, which is currently 
supported by a large number of manufacturers. CANopen was published 
under the heading of DS-301 by the CAN in Automation association (CIA). 
The communication specifications DS-301 define standards for CAN 
devices. These specifications mean that the equipment supplied by 
different manufacturers is interchangeable. The compatibility of the 
equipment is further enhanced by the equipment specification DS-401 that 
defines standards for the technical data and process data of the equipment. 
DS-401 contains the standards for digital and analog input/output modules. 
CANopen comprises a communication profile that defines the objects that 
must be used for the transfer of certain data as well as the device profiles 
that specify the type of data that must be transferred by means of other 
objects. 
The CANopen communication profile is based upon an object directory that 
is similar to the profile used by PROFIBUS. The communication profile DS-
301 defines two standard objects as well as a number of special objects: 
 
• Process data objects (PDO)  

PDOs are used for real-time data transfers 
• Service data objects (SDO)  

SDOs provide access to the object directory for read and write 
operations 

 

General 

CANopen 
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CAN is based on a linear bus topology. You can use router nodes to 
construct a network. The number of devices per network is only limited by 
the performance of the bus driver modules. 
The maximum distance covered by the network is determined by the 
runtimes of the signals. This means that a data rate of 1Mbaud limits the 
network to 40m and 80kBaud limits the network to 1000m. 
The CAN-Bus communication medium employs a screened three-core 
cable (optionally a five-core).  
The CAN-Bus operates by means of differential voltages. For this reason it 
is less sensitive to external interference than a pure voltage or current 
based interface. The network must be configured as a serial bus, which is 
terminated by a 120Ω terminating resistor.  
Your VIPA CAN-Bus coupler contains a 9pin socket. You must use this 
socket to connect the CAN-Bus coupler as a slave directly to your CAN-Bus 
network.  
All devices on the network use the same baudrate. 
Due to the bus structure of the network it is possible to connect or 
disconnect any station without interruption to the system. It is therefore also 
possible to commission a system in various stages. Extensions to the 
system do not affect the operational stations. Defective stations or new 
stations are recognized automatically. 
 

Bus access methods are commonly divided into controlled (deterministic) 
and uncontrolled (random) bus access systems. 
CAN employs a Carrier-Sense Multiple Access (CSMA) method, i.e. all 
stations have the same right to access the bus as long as the bus is not in 
use (random bus access).  
Data communications is message related and not station related. Every 
message contains a unique identifier, which also defines the priority of the 
message. At any instance only one station can occupy the bus for a 
message. 
CAN-Bus access control is performed by means of a collision-free, bit-
based arbitration algorithm. Collision-free means that the final winner of the 
arbitration process does not have to repeat his message. The station with 
the highest priority is selected automatically when more than one station 
accesses the bus simultaneously. Any station that is has information to 
send will delay the transmission if it detects that the bus is occupied. 
 
 
 

Communication 
medium 

Bus access 
method 



Chapter 3   Deployment IM 208CAN Manual VIPA System 200V 

3-4  HB97E - IM - RE_208-1CA00 - Rev. 15/14 

Project engineering 
 

The project engineering of the CANopen master happens in WinCoCT 
(Windows CANopen Configuration Tool) from VIPA. You export your 
project from WinCoCT as wld-file. This wld-file can then be imported into 
the hardware configurator from Siemens. 
 

For the deployment of System 200V modules and the CAN master, you 
have to include the System 200V modules into the hardware catalog via the 
GSD-file from VIPA. For the project engineering in the hardware 
configurator you have to execute the following steps: 
• Start WinCoCT and project the CANopen network. 

• Create a master group with  and insert a CANopen master via . 
• Activate the master function via "Device Access" and "Device is NMT 

Master". 
• Activate in the register "CANopen Manager" Device is NMT Master and 

confirm your entry. 
• Set parameters like diagnosis behavior and CPU address ranges with 

"Set PLC Parameters". 

• Create a slave group with  and add your CANopen slaves via . 
• Add modules to your slaves via "Modules" and parameterize them if 

needed. 
• Set your process data connections in the matrix via "Connections" and 

proof your entries if needed in the process image of the master. 
• Save the project and export it as wld-file. 
• Switch to the SIMATIC manager from Siemens and copy the data block 

from the CAN-wld-file into the block directory. 
• Project the PROFIBUS DP master system in the hardware configurator 

with the following Siemens-CPU: CPU 315-2DP (6ES7 315-2AF03-
0AB0)  

• The DP master receives an address >1. 
• Add the System 200V DP slave system from the hardware catalog to the 

master system.  
• The System 200V DP slave system always requires the address 1.  
• Save all and transfer the PLC project together with the wld-file via MPI 

into the CPU. 
In the following you’ll find a description of this steps. 
 
Note! 
Starting with the firmware version 3.5.0, please use the hardware catalog 
CPU 6ES7-315-2AF03 V1.2 from Siemens for the project engineering of 
the VIPA standard CPUs of the Systems 100V, 200V, 300V and 500V! 

Fast introduction 
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The hardware configurator is a part of the Siemens SIMATIC Manager. It 
serves the project engineering. The modules that can be parameterized 
with are monitored in the hardware catalog. 
For the deployment of the System 200V modules, the inclusion of the 
System 200V modules into the hardware catalog is necessary. This 
happens via a GSD-file from VIPA. 
 

Note! 
For the project engineering a thorough knowledge of the Siemens SIMATIC 
manager and the hardware configurator from Siemens is required! 
 

• Copy the delivered VIPA GSD-file VIPA_21x.gsd into your GSD-
directory... \siemens\step7\s7data\gsd   

• Start the hardware configurator from Siemens 
• Close all projects 
• Choose Options > Install new GSD-file 
• Select VIPA_21x.GSD 
Now the modules of the System 200V from VIPA are integrated in the 
hardware catalog and can be projected. 
 

 
 

To be compatible to the Siemens SIMATIC Manager, the System 200V CPUs from VIPA 
have to be projected as  

CPU 315-2DP (6ES7 315-2AF03-0AB0)! 

To be able to directly address the modules, you have to include them in the hardware 
configurator from Siemens in form of a virtual PROFIBUS system. By including the 
GSD-file from VIPA, you are able to access the complete function range of the 
modules. 
The concrete project engineering happens in the CANopen configuration tool 
WinCoCT. You may export your project as wld-file and transfer it as DB into your PLC 
program. 
 

 
 

Precondition for 
the project 
engineering 

     

Include GSD-file 

Note 
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WinCoCT (Windows CANopen Configuration Tool) is a configuration tool 
developed from VIPA to allow the comfortable project engineering of 
CANopen networks. 
WinCoCT monitors the CANopen network topology in a graphical user 
interface. Here you may place, parameterize and group field devices and 
controls and engineer connections.  
The selection of the devices happens via a list that can be extended for 
your needs with an EDS-file (Electronic Data Sheet) at any time.  
A right click onto a device opens a context menu consisting partly of static 
and partly of dynamic components. 
For the configuration of the process data exchange, all process data are 
monitored in a matrix with the device inputs as rows and the device outputs 
as columns. Mark a cross point to create the wanted connection.  
The telegram collection and optimization is executed by WinCoCT.  
 

 

WinCoCT 
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Via Tools > Project options you may preset CAN specific parameters like 
baud rate, selection of the master etc. 
More detailed information is to find in the WinCoCT manual. 
 

WinCoCT allows you to preset VIPA specific parameters for the CAN 
master by doing a right click onto the master and call the following dialog 
window with Set PLC-Parameters: 
 

 
 
Reserved for later extensions 
 
Plug-in location no. at the bus 
0: For the addressing of the CAN master integrated in the CPU 
1 ... 32: For the addressing of CAN master at the standard bus 
 
Fix at 0x195 
 
 
Here you can define the reaction of the output channels if the CPU 
switches to STOP. The following values are available: 
Switch substitute value 0: Sets all outputs to 0 
Keep last value: Keeps the recent state of the outputs. 
 

Set project 
parameters 

Parameter  
CAN master 

PLC Type 

Slot number 

CANopen 
DeviceProfileNumber 

Behavior at  
PLC-STOP 
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Here you set the reaction for the slave input data in case of a slave failure. 
Switch substitute value 0: The data is set to 0. 
Keep the last value: The recent date remain unchanged. 
 

This area allows you to define the diagnostic reaction of the CAN master. 
Diagnostic: Activates the diagnostic function 
CANopen state: When activated, the CAN master sends its state 
"preoperational" or "operational" to the CPU. You may request the state via 
SFC 13. 
Slave failure/recovery: When activated, the OB 86 is called in the CPU in 
case of slave failure and reboot. 
Error control: If this option is selected, the NMT master sends all Guarding 
errors as diagnosis to the CPU, that calls the OB 82.  
Emergency Telegram: At activation, the NMT master sends all Emergency 
telegrams as diagnosis to the CPU, that calls the OB 82. 
 

The following fields allow you to preset the address ranges in the CPU for 
the CANopen master in- and output ranges. Each block consists of 4Byte. 
Input addr. 6000, Input blocks 
PI basic address in the CPU that are occupied from 0x6000 CAN input 
data. For input blocks max. 16 (64Byte) can be entered. 
Output addr. 6000, Output blocks 
PO basic address in the CPU that are occupied from 0x6000 CAN output 
data. For output blocks max. 16 (64Byte) can be entered. 
Input addr. A000, Input blocks 
PI basic address in the CPU that are occupied from 0xA000 CAN input 
network variables. For input blocks max. 80 (320Byte) can be entered. 
Output addr. A000, Output blocks 
PO basic address in the CPU that are occupied from 0xA000 CAN output 
network variables. For output blocks max. 80 (320Byte) can be entered. 
 

To enable the master to access a CANopen slave, you have to register it at 
the according master via WinCoCT. Right click onto your CAN master, 
choose "Device access" and switch to the register "CANopen Manager". 
Via [Change] you can register every single slave res. via [Global] all slaves 
at your master and preset the error behavior. 
Please don’t forget to apply the settings into your project engineering 
by clicking on [Apply to slaves]. 

Behavior at Slave 
breakdown 

Diagnostic 

Address range in 
the CPU 

Activate CANopen 
slave in the 
CANopen Manager 



Manual VIPA System 200V Chapter 3   Deployment IM 208CAN 

HB97E - IM - RE_208-1CA00 - Rev. 15/14  3-9 

The following text describes the approach of the project engineering with an 
abstract sample: 
The project engineering is divided into three parts: 
• CAN master project engineering in WinCoCT and export as wld-file 
• Import CAN master project engineering 
• Project engineering of the modules 
 
For the project engineering of a CANopen system, the most recent EDS-file 
has to be transferred into the EDS-directory of WinCoCT.  
For the deployment of the System 200V modules, you have to include the 
System 200V modules with the GSD-file VIPA_21x.gsd from VIPA into the 
hardware catalog.  
 
• Copy the required EDS-files into the EDS-directory and start WinCoCT. 

• Create a master group via  and insert a CANopen master via  
(VIPA_208_1CA00.eds). 

• Create a slave group with  and add your CANopen slaves via . 
• Right click on the according slave and add the needed modules via 

„Modules“. 
• Parameterize the modules with [Parameter] res. via the according object 

directory. 
• Right click on the master and open the dialog "Device Access". 
• Activate Device is NMT Master in the register "CANopen Manager" and 

register the according slaves at the master. Don’t forget to apply your 
settings into your project engineering with [Apply to slaves]! 

 

 

Steps of the 
project 
engineering 

Preconditions 

CAN master project 
engineering in 
WinCoCT 
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• Right click onto the master and open the VIPA specific dialog 
"Set PLC Parameters". Here you may adjust the diagnosis 
behavior and the address ranges that the master occupies in 
the CPU.   
Under "Slot number" type the slot no., where your CAN master 
is plugged. At export, WinCoCT creates the according DB no. + 
2000. 

 

 

• Change to the register "Connections" in the main window. Here 
the process data are shown in a matrix as inputs (1. column) 
and as outputs (1. row).   
To monitor the process data of a device with a "+" click on the 
according device. 

• For helping you, you may only define a connection when the 
appearing cross has green color. Select the according cell with 
the mouse pointer in row and column in the matrix and click on 
it. → The cell is marked with a " ". You can control the 
connection by changing into "Devices", click on the master and 
monitor the process image of the master via "Device Access". 

• Save your project. 
• Via File > Export your CANopen project is exported into a wld-

file. The name is the combination of project name + node 
address + ID Master/Slave. 

Now your CANopen project engineering under WinCoCT is ready. 
 

 
 
 

... CAN master 
project engineering 
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• Start the SIMATIC manager from Siemens with your PLC project and 
open the wld-file via File > Memory Card File > open. 

• Copy the DB 2xxx into your block directory. 
• Start the hardware configurator from Siemens with a new project and 

insert a profile rail from the hardware catalog. 
• Place the following Siemens CPU onto plug-in location 2:  

CPU 315-2DP (6ES7 315-2AF03-0AB0). For the project engineering of 
the VIPA standard CPUs of the Systems 100V, 200V, 300V and 500V 
please use starting with the firmware version 3.5.0 the CPU 6ES7-315-
2AF03 V1.2 from Siemens from the hardware catalog! 

• If for example your CAN master module is directly placed beside the 
CPU, you project your CAN master on plug-in location 4. 

• Starting with plug-in location 5, you include your System 200V modules 
on the standard bus in the plugged sequence. 

• Parameterize your CPU res. the modules when needed. The parameter 
window is opened when you double click on the according module. 

• Save your project and transfer it to your CPU. 
 
After the transfer the CPU recognizes the DB for the CAN master and 
passes the contents of the DB on to the according CAN master at STOP-
RUN change.  
 

 

Import into PLC 
program and 
transfer to CAN 
master 
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Firmware update 
 

Starting with CPU firmware version 3.4.8 a MMC inside your CPU can be 
used to update the firmware of CPU an CAN master. The latest 2 firmware 
versions are to find in the service area at www.vipa.com. For more details 
see the manual of the CPU. 
For designation the master firmware has the following name convention: 
 
canxx.bin        xx specifies the slot number the CAN master is plugged in (Slot: 01 ... 32)  

 
 
Attention! 
When installing a new firmware you have to be extremely careful. Under 
certain circumstances you may destroy the CAN-Master, for example if the 
voltage supply is interrupted during transfer or if the firmware file is 
defective. 
In this case, please call the VIPA-Hotline! 
 

A label on the rear of the module indicates the firmware version. 
 

• Go to www.vipa.com  
• Click on Service > Download > Firmware Updates. 
• Click on "Firmware for CAN Master System 200V". 
• Select the according IM 208 order no. and download the firmware to 

your PC. 
• Rename the file to "canxx.bin" (xx specifies the slot number the DP 

master is plugged in, starting with 01) and transfer this file onto a MMC. 
 
 
Note! 
The server always stores the latest two firmware versions. 
 
 
 

Overview 

 

Seek  
firmware version 

Load firmware and 
transfer it to MMC 
as canxx.bin 
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Mode 
 

DB2xxx from 
PLC?

Power On

DB2xxx OK?

all Slaves 
operational?

wait to Master
communication

j

j

j

time_out > 
10s?n n

IF-LED on

j

Typ = Master?

configure master
IF-LED off

configure slaves

j

LED BA on
Master mode: 

operational

Slaves: operational

ERR-LED off

Data exchange

ERR-LED on
configure slave

Configuration 
OK?

Slave: operational

j

n

n

IF-LED on
ERR-LED onn

configure Slave

ERR-LED off
IF-LED off

BA-LED blinks (1Hz)
 Slave:

pre-operational

n

 

STOP →→→→ RUN (automatically) 
After PowerON and at valid project data in the 
CPU, the master switches automatically into 
RUN. The master has no operating mode lever.
After PowerON, the project data is auto-
matically send from the CPU to the CAN 
master. This establishes a communication to 
the CAN slaves.  
At active communication and valid bus 
parameters, the CAN master switches into the 
state "operational". The LEDs RUN and BA are 
on. 
At invalid parameters, the CAN master remains 
in STOP and shows the parameterization error 
via the IF-LED.  
 
RUN 
In RUN, the RUN- and BA-LEDs are on. Now 
data can be exchanged.  
In case of an error, like e.g. slave failure, the 
ERR-LED at the CAN master is on and an 
alarm is send to the CPU. 
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Process image 
 

The process image is build of the following parts: 
• Process image for input data (PI) for RPDOs 
• Process image for output data (PO) for TPDOs 
Every part consists of 64byte "Digital-Data"- and 320Byte "Network 
Variables". 
 

For input data, the following objects are available: 
• 8 Bit digital input (Object 0x6000) 
• 16 Bit digital input (Object 0x6100) 
• 32 Bit digital input (Object 0x6120) 
• 8 Bit input network variables (Object 0xA040) 
• 16 Bit input network variables (Object 0xA100) 
• 32 Bit input network variables (Object 0xA200) 
• 64 Bit input network variables (Object 0xA440) 
 
Like to see in the following illustration, the objects of the digital input data 
use the same memory area of the CPU. 
For example, an access to Index 0x6000 with Subindex 2 corresponds an 
access to Index 0x6100 with Subindex 1. Both objects occupy the same 
memory cell in the CPU. 
Please regard that the input network variables also use the same memory 
area. 
  

PDO3
PDO2

PDO1

0

1

2

3

4

0

1

.

.

.
.
.
.

PA

CMS*
WDW

OUT

Mapping

CAN DI

0

1

2

3

4

5

6

7

8

9
.
.
.

CPU
Offset +

0

1

2

3

4

5

6

7

8

9
.
.
.

B

TPDO

PE

 
*)  CMS = CANopen master/slave 

 
 

Input data 
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For the digital output data, the assignment is similar. 
For output data, the following objects are available: 
• 8 Bit digital output (Object 0x6200) 
• 16 Bit digital output (Object 0x6300) 
• 32 Bit digital output (Object 0x6320) 
• 8 Bit output network variables (Object 0xA400) 
• 16 Bit output network variables (Object 0xA580) 
• 32 Bit output network variables (Object 0xA680) 
• 64 Bit output network variables (Object 0xA8C0) 
 
Like to see in the following illustration, the objects of the digital output data 
use the same memory area of the CPU. 
For example, an access to Index 0x6200 with Subindex 2 corresponds an 
access to Index 0x6300 with Subindex 1. Both objects occupy the same 
memory cell in the CPU. 
Please regard that the output network variables also use the same memory 
area. 
  

PDO3
PDO2

PDO1

0

1

2

3

4

0

1

.

.

.
.
.
.

PAPE

CMS*
WDW
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Mapping

CAN DO

0

1

2

3

4

5

6

7

8

9
.
.
.

CPU
Offset +

0

1

2

3

4

5

6

7

8

9
.
.
.

B

RPDO

 
*)  CMS = CANopen master/slave 

 
 

 
 
 
 

Output-data 
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Messages 
 

All CANopen messages have the following structure according to 
CIA DS-301: 
Identifier 

Byte Bit 7 ... Bit 0 
1 Bit 3 ... Bit 0: most significant 4 bits of the module-ID 

Bit 7 ... Bit 4: CANopen function code 
2 Bit 3 ... Bit 0: data length code (DLC) 

Bit 4: RTR-Bit: 0: no data (request code) 
    1: data available 
Bit 7 ... Bit 5: Least significant 3 bits of the module-ID 

 

Data 
Byte Bit 7 ... Bit 0 

3 ... 10 Data 
 
An additional division of the 2Byte identifier into function portion and a 
module-ID gives the difference between this and a level 2 message. The 
function determines the type of message (object) and the module-ID 
addresses the receiver. 
CANopen devices exchange data in the form of objects. The CANopen 
communication profile defines two different object types as well as a 
number of special objects. 
 
The VIPA CAN master supports the following objects: 
• 40 Transmit PDOs (PDO Linking, PDO Mapping) 
• 40 Receive PDOs (PDO Linking, PDO Mapping) 
• 2 Standard SDOs (1 Server, 127 Clients) 
• 1 Emergency Object 
• 1 Network management Object NMT 
• Node Guarding 
• Heartbeat 
 
Note! 
The exact structure and data content of all objects is described in the CIA-
Profiles DS-301, DS-302, DS-401 and DS-405. 
 

Identifier 

Data 
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A CANopen device can be structured as follows: 
 

Communication

Status machine

SDO

PDO

PDO

SYNC

NMT
Heartbeat or

Node Guarding

SDO

Status machine

Application
Object

Object directory

Index Subind. Value

entry 1
entry 2
entry 3
      .
      .
      .

entry n

Application

Application
Object

Application
Object

Application
Object

Application
Object

Pr
oc

es
s 

(I/
O

s)

C
A

N
 b

us
 s

ys
te

m

...

 
 

Communication 
Serves the communication data objects and the concerning functionality for 
data transfer via the CANopen network.  
Application 
The application data objects contain e.g. in- and output data. In case of an 
error, an application status machine switches the outputs in a secure state. 
The object directory is organized as 2 dimension table. The data is addres-
sed via index and sub-index. 
Object directory 
This object directory contains all data objects (application data +  
parameters) that are accessible and that influence the behavior of 
communication, application and status machines. 
 

In many fieldbus systems the whole process image is transferred - mostly 
more or less cyclically. CANopen is not limited to this communication 
principle, for CAN supports more possibilities through multi master bus 
access coordination.  
CANopen divides the process data into segments of max. 8Byte. These 
segments are called process data objects (PDOs). Every PDO represents 
one CAN telegram and is identified and prioritized via its specific CAN 
identifier. 
For the exchange of process data, the VIPA CAN-Master supports 80 
PDOs. Every PDO consists of a maximum of 8 data bytes. The transfer of 
PDOs is not verified by means of acknowledgments since the CAN protocol 
guarantees the transfer. 
There are 40 Tx transmit PDOs for input data and 40 Rx receive PDOs for 
output data. The PDOs are named seen from the CAN-Master: 
Receive PDOs (RxPDOs) are received by the CAN-Master and contain 
input data. 
Transmit PDOs (TxPDOs) are send by the CAN-Master and contain output 
data. 
The assignment of the PDOs to input or output data occurs via WinCoCT 
automatically 

Structure of the 
device model 

PDO 
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For access to the object directory, the Service-Data-Object (SDO) is used. 
The SDO allows you a read or write access to the object directory. In the 
CAL-Layer-7-Protocol you find the specification of the Multiplexed-Domain-
Transfer-Protocol that is used by the SDOs. This protocol allows you to 
transfer data with any length. At need, the messages are divided into 
several CAN messages with identical identifier (segmentation). A SDO is 
transferred acknowledged, i.e. every reception of a message is 
acknowledged. 
 
Note! 
A more detailed description of the SDO telegrams is to find in the CiA norm 
DS-301. 
In the following only the error messages are described that may occur at a 
wrong parameter communication. 
 
Every CPU has the SFC 219 integrated. This allows you to start a SDO 
read or write access from your PLC program to the CAN master. 
You address your master via the plug-in location and the destination slave 
via its CAN address. The process data is defined by index and subindex. 
Via SDO every access transfers max. one data word process data. The 
SFC 219 contains the following parameters: 
 

Parameter Declaration Type Description 
REQUEST IN BOOL  
SLOT_MASTER IN BYTE  
NODEID IN BYTE  
TRANSFERTYP IN BYTE  
INDEX IN DWORD  
SUBINDEX IN DWORD  
CANOPENERROR OUT DWORD  
RETVAL OUT WORD  
BUSY OUT BOOL  
DATABUFFER IN_OUT ANY  

 
Control parameter: 1: Start the order 
 
0: VIPA 21x-2CM0x 
1...32: VIPA 208-1CA00, depending on plug-in location no. 
 
Address of the CANopen node (1...127) 
 
40h, 60h: Read SDO 61h: Write SDO (undefined length) 
 23h: Write SDO (1 DWORD) 
 2Bh: Write SDO (1 WORD) 
 2Fh: Write SDO ( 1 BYTE) 
 
CANopen Index 
 
CANopen Subindex 

SDO 

     

SFC 219 CAN_TLGR 
SDO request to CAN 
master 

REQUEST 

SLOT_MASTER 

NODELD 

TRANSFER TYPE 

INDEX 

SUBINDEX 
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If no error occurs CANOPENERROR returns value 0. 
In case of error the CANOPENERROR contains one of the following error 
messages which are generated in the CAN master: 
 

Code Description 
0x05030000 Toggle bit not alternated 
0x05040000 SDO protocol timed out 
0x05040001 Client/server command specifier not valid or unknown 
0x05040002 Invalid block size (block mode only) 
0x05040003 Invalid sequence number (block mode only) 
0x05040004 CRC error (block mode only) 
0x05040005 Out of memory 
0x06010000 Unsupported access to an object 
0x06010001 Attempt to read a write only object 
0x06010002 Attempt to write a read only object 
0x06020000 Object does not exist in the object dictionary 
0x06040041 Object cannot be mapped to the PDO 
0x06040042 The number and length of the objects to be mapped would exceed PDO length 
0x06040043 General parameter incompatibility reason 
0x06040047 General internal incompatibility in the device 
0x06060000 Access failed due to an hardware error 
0x06070010 Data type does not match, length of service parameter does not match 
0x06070012 Data type does not match, length of service parameter too high 
0x06070013 Data type does not match, length of service parameter too low 
0x06090011 Sub-index does not exist 
0x06090030 Value range of parameter exceeded (only for write access) 
0x06090031 Value of parameter written too high 
0x06090032 Value of parameter written too low 
0x06090036 Maximum value is less than minimum value 
0x08000000 general error 
0x08000020 Data cannot be transferred or stored to the application 
0x08000021 Data cannot be transferred or stored to the application because of local control 
0x08000022 Data cannot be transferred or stored to the application because of the present 

device state 
0x08000023 Object dictionary dynamic generation fails or no object dictionary is present (e.g. 

object dictionary is generated from file and generation fails because of an file 
error) 

 

CANOPENERROR 
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When the function has been executed successfully, the return value 
contains the valid length of the respond data: 1: BYTE, 2: WORD, 4: 
DWORD.  
If an error occurs during function processing, the return value contains an 
error code. 
 

Value Description 
F021h Invalid slave address (Call parameter equal 0 or above 127) 
F022h Invalid Transfer type (Value unequal 60h, 61h) 
F023h Invalid data length (data buffer to small, at SDO read access it should be at 

least 4Byte, at SDO write access 1Byte, 2Byte or 4Byte). 
F024h The SFC is not supported 
F025h Write buffer in the CANopen master full, service can not be processed at this 

time. 
F026h Read buffer in the CANopen master full, service can not be processed at this 

time. 
F027h The SDO read or write access returned wrong answer, see CANopen Error 

Codes. 
F028h SDO-Timeout (no CANopen participant with this Node-Id has been found). 

 

Busy = 1: The read/write job is not yet completed. 
 

SFC data communication area. 
Read SDO: Destination area for the SDO data that were read. 
Write SDO: Source area for the SDO data that were write. 
 

Note 
Unless a SDO demand was processed error free, RETVAL contains the 
length of the valid response data in 1, 2 or 4 byte and the CANOPENERROR 
the value 0. 
 
 
 
 
 

RETVAL 

BUSY 

DATABUFFER 
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Object directory 
 

The CANopen object directory contains all relevant CANopen objects for 
the bus coupler. Every entry in the object directory is marked by a 16Bit 
index. 
If an object exists of several components (e.g. object type Array or Record), 
the components are marked via an 8Bit sub-index. 
The object name describes its function. The data type attribute specifies the 
data type of the entry.  
The access attribute defines, if the entry may only be read, only be written 
or read and written.  
The object directory is divided into the following 3 parts: 
 

This area contains the description of all relevant parameters for the 
communication. 
0x1000 – 0x1011 General communication specific parameters  

(e.g. device name) 
0x1400 – 0x1427 Communication parameters (e.g. identifier) of the 

receive PDOs 
0x1600 – 0x1627 Mapping parameters of the receive PDOs 

The mapping parameters contain the cross-
references to the application objects that are 
mapped into the PDOs and the data width of the 
depending object. 

0x1800 – 0x1827 
0x1A00 – 0x1A27 

Communication and mapping parameters of the 
transmit PDOs 

 

Here you find the manufacturer specific entries. The CAN master from 
VIPA has no manufacturer specific entries. 
 

This area contains the objects for the device profile acc. DS-401. 
 

 
Note! 
For the CiA norms are exclusively available in English, we adapted the 
object tables. Some entries are described below the according tables. 

Structure 

Communication  
specific profile area 
(0x1000 – 0x1FFF) 

Manufacturer specific 
profile area 
(0x2000 – 0x5FFF) 

Standardized device 
profile area 
(0x6000 – 0x9FFF) 
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Index Content of Object 
1000h  Device type 
1001h Error register 
1005h COB-ID SYNC 
1006h Communication Cycle Period 
1007h Synchronous Window Length 
1008h Manufacturer Hardware Version 
1009h Hardware Version  
100Ah Software Version  
100Ch Guard Time 
100Dh Life Time Factor 
1016h Consumer Heartbeat Time 
1017h Producer Heartbeat Time 
1018h Identity Object 
1400h ... 1427h Receive PDO Communication Parameter 
1600h ... 1627h Receive PDO Mapping Parameter 
1800h ... 1827h Transmit PDO Communication Parameter 
1A00h ... 1A27h Transmit PDO Mapping Parameter 
1F22h Concise DCF 
1F25h Post Configuration 
1F80h NMT StartUp 
1F81h Slave Assignment 
1F82h Request NMT 
1F83h Request Guarding 
6000h Digital-Input-8-Bit Array (see DS 401) 
6100h Digital-Input-16-Bit Array (see DS 401) 
6120h Digital-Input-32Bit Array (see DS 401) 
6200h Digital-Output-8-Bit Array (see DS 401) 
6300h Digital-Output-16-Bit Array (see DS 401) 
6320h Digital-Output-32-Bit Array (see DS 401) 
A040h Dynamic Unsigned8 Input 
A100h Dynamic Unsigned16 Input 
A200h Dynamic Unsigned32 Input 
A4400h Dynamic Unsigned64 Input 
A4C0h Dynamic Unsigned8 Output 
A580h Dynamic Unsigned16 Output 
A680h Dynamic Unsigned32 Output 
A8C0h Dynamic Unsigned64 Output 

Object directory 
overview 
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Index Sub-

index 
Name Type Attr. Map. Default value Meaning 

0x1000 0 Device 
Type 

Unsigned32 ro N 0x00050191 Statement of device type 

 
The 32Bit value is divided into two 16Bit fields: 
 
MSB LSB 
Additional information Device profile number 
0000 0000 0000 wxyz (bit) 405dec=0x0195 

 
The "additional information" contains data related to the signal types of the 
I/O device: 
z=1  digital inputs  
y=1  digital outputs  
x=1  analog inputs 
w=1  analog outputs 
 

 
Index Sub- 

Index 
Name Type Attr. Map. Default value Meaning 

0x1001 0 Error 
Register 

Unsigned8 ro Y 0x00 Error register 

 
Bit 7       Bit 0 
ManSpec reserved reserved Comm. reserved reserved reserved Generic 

 
ManSpec.: Manufacturer specific error, specified in object 0x1003. 
Comm.: Communication error (overrun CAN) 
Generic:  A not more precisely specified error occurred (flag is set at 

every error message) 
 

 
Index Sub- 

Index 
Name Type Attr. Map. Default value Meaning 

0x1005 0 COB-Id sync 
message 

Unsigned32 ro N 0x80000080 Identifier of the SYNC 
message 

 
The lower 11Bit of the 32Bit value contain the identifier (0x80=128dez), 
while the MSBit indicates whether the device receives the SYNC telegram 
(1) or not (0). 
Attention: In contrast to the PDO identifiers, the MSB being set indicates 
that this identifier is relevant for the node. 

Device Type 

Error register 

SYNC identifier 
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Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1006 0 Communi-
cation 
cycle period 

Unsigned32 rw N 0x00000000 Maximum length of the 
SYNC interval in µs.  

 
If a value other than zero is entered here, the master goes into error state if 
no SYNC telegram is received within the set time during synchronous PDO 
operation. 
 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x1007 0 Synchronou
s window 
length 

Unsigned32 rw N 0x00000000 Contains the length of time 
window for synchronous 
PDOs in µs. 

 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1008 0 Manufacturer 
device name 

Visible string ro N  Device name of the bus 
coupler 

 
VIPA Master / Slave 208-1CA00 
 
Since the returned value is longer than 4Byte, the segmented SDO protocol 
is used for transmission. 
 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1009 0 Manufacturer 
Hardware 
version 

Visible string ro N 1.00 Hardware version number 
of bus coupler 

 
 
 
Since the returned value is longer than 4Byte, the segmented SDO protocol 
is used for transmission. 
 

SYNC interval 

Synchronous 
Window Length 

Device name 

Hardware version 
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Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x100A 0 Manufacturer 
Software 
version 

Visible string ro N 1.xx Software version number 
CANopen software 

 
 
Since the returned value is longer than 4Byte, the segmented SDO protocol 
is used for transmission. 
 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x100C 0 Guard time 
[ms] 

Unsigned16 rw N 0x0000 Interval between two guard 
telegrams. Is set by the NMT 
master or configuration tool.

 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x100D 0 Life time 
factor 

Unsigned8 rw N 0x00 Life time factor x guard time 
= life time (watchdog for life 
guarding) 

 
If a guarding telegram is not received within the life time, the node enters 
the error state. If the life time factor and/or guard time =0, the node does 
not carry out any life guarding, but can itself be monitored by the master 
(node guarding). 
 
 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x1016 0 Consumer 
heartbeat 
time 

Unsigned8 ro N 0x05 Number of entries 

 1...127  Unsigned32 rw N 0x00000000 Consumer heartbeat time 
 
Structure of the "Consumer Heartbeat Time" entry:: 
Bits 31-24 23-16 15-0 
Value Reserved Node-ID Heartbeat time 
Encoded as Unsigned8  Unsigned8 Unsigned16 
 
As soon as you try to configure a consumer heartbeat time unequal zero for 
the same node-ID, the node interrupts the SDO download and throws the 
error code 0604 0043hex. 

Software version 

Guard time 

Life time factor 

Consumer 
Heartbeat Time 
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Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x1017 0 Producer 
heartbeat 
time 

Unsigned16 rw N 0x0000 Defines the cycle time of 
heartbeat in ms 

 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1018 0 Identity 
Object 

Unsigned8 ro N 0x04 Contains general 
Information about the 
device (number of entries) 

 1 Vendor ID Unsigned32 ro N 0xAFFEAFFE Vendor ID 
 2 Product 

Code 
Unsigned32 ro N 0x2081CA00 Product Code 

 3 Revision 
Number 

Unsigned32 ro N  Revision Number 

 4 Serial 
Number 

Unsigned32 ro N  Serial Number 

 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x1400 
... 

 

0x1427 

0 Number of 
Elements 

Unsigned8 ro N 0x02 Communication parameter 
for the first receive PDOs, 
Subindex 0: number of 
following parameters 

 1 COB-ID Unsigned32 rw N 0xC0000200 
+ NODE_ID 

COB-ID RxPDO1 

 2 Transmis-
sion type 

Unsigned8 rw N 0xFF Transmission type of the 
PDO 
 

 
Sub-index 1 (COB-ID): The lower 11Bit of the 32Bit value (Bits 0-10) 
contain the CAN identifier, the MSBit (Bit 31) shows if the PDO is active (0) 
or not (1), Bit 30 shows if a RTR access to this PDO is permitted (0) or not 
(1).  
The sub-index 2 contains the transmission type. 
 
 
 

Producer 
Heartbeat Time 

Identity Object 

Communication 
parameter RxPDO 
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Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1600 
... 
 

0x1627 

0 Number of 
Elements 

Unsigned8 rw N 0x01 Mapping parameter of the 
first receive PDO; subindex 
0: number of mapped 
objects 

 1 1st mapped 
object 

Unsigned32 rw N 0x62000108 (2 byte index, 
1 byte subindex, 
1 byte bit-width) 

 2 2nd mapped 
object 

Unsigned32 rw N 0x62000208 (2 byte index, 
1 byte subindex, 
1 byte bit-width) 

 ... ... ... ... ... ... ... 
 8 8th mapped Unsigned32 rw N 0x62000808 (2 byte index, 

1 byte subindex, 
1 byte bit-width) 

 
The reception PDOs get a default mapping automatically from the master 
depending on the connected modules. 
 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x1800 
... 
 

0x1827 

0 Number of 
Elements 

Unsigned8 ro N 0x05 Communication parameter 
of the first transmit PDO, 
subindex 0: number of 
following parameters 

 1 COB-ID Unsigned32 rw N 0x80000180 + 
NODE_ID 

COB-ID TxPDO1 

 2 Transmission 
type 

Unsigned8 rw N 0xFF Transmission type of the 
PDO 
 

 3 Inhibit time Unsigned16 rw N 0x0000 Repetition delay 
[value x 100 µs] 

 5 Event time Unsigned16 rw N 0x0000 Event timer [value x 1 ms] 
 
Sub-index 1 (COB-ID): The lower 11Bit of the 32Bit value (Bits 0-10) 
contain the CAN identifier, the MSBit (Bit 31) shows if the PDO is active (0) 
or not (1), Bit 30 shows if a RTR access to this PDO is permitted (0) or not 
(1). The sub-index 2 contains the transmission type, sub-index 3 the 
repetition delay time between two equal PDOs. If an event timer exists with 
a value unequal 0, the PDO is transmitted when the timer exceeds.  
If a inhibit timer exists, the event is delayed for this time. 

Mapping RxPDO 

Communication 
parameter TxPDO1 
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Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1A00 
... 
 

0x1A27 

0 Number of 
Elements 

Unsigned8 rw N depending on 
the 
components 
fitted 

Mapping parameter of the 
first transmit PDO; 
subindex 0: number of 
mapped objects 

 1 1st mapped 
object 

Unsigned32 rw N 0x60000108 (2 byte index, 
1 byte subindex, 
1 byte bit-width) 

 2 2nd mapped 
object 

Unsigned32 rw N 0x60000208 (2 byte index, 
1 byte subindex, 
1 byte bit-width) 

 ... ... ... ... ... ... ... 
 8 8th mapped 

object 
Unsigned32 rw N 0x60000808 (2 byte index, 

1 byte subindex, 
1 byte bit-width) 

 
The send PDOs get a default mapping automatically from the coupler 
depending on the connected modules.  
 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1F22 Array Concise DCF Domain rw N   
 
This object is required for the Configuration Manager. The Concise-DCF is 
the short form of the DCF (Device Configuration File). 
 
 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x1F25 Array ConfigureSlav
e 

Unsigned32 rw N 0x00000000  

 
Via this entry, the Configuration Manager can be forced to transfer a stored 
configuration into the net. 
The configuration can be initiated for a defined node at any time via the 
index 0x1F25.  
Subindex 0 has the value 128. 
Subindex x (with x = 1..127): Starts the reconfiguration for nodes with the 
    node ID x. 
Subindex 128: reconfiguration of all nodes. 
 
For example: If you want to initiate the configuration for node 2 and there 
are configuration data for this node available, you have to write the value 
0x666E6F63 (ASCII = "conf") to the object 1F25h Subindex 2. 
 

Mapping TxPDO1 

Concise DCF 

Post Configuration 
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Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1F80 0x00 NMTStartup Unsigned32 rw N 0x00000000  
 
Define the device as NMT master. 
 
Bit Meaning 
Bit 0 0 : Device is NOT the NMT Master. All other bits have to be 

     ignored. The objects of the Network List have to be ignored. 
1 : Device is the NMT Master. 

Bit 1 0  : Start only explicitly assigned slaves. 
1  : After boot-up perform the service NMT Start Remote Node 
      All Nodes 

Bit 2..31 Reserved by CiA, always 0 
 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1F81 0x00 SlaveAssignment Unsigned32 rw N 0x00000000  
 
Enter the nodes that are controlled by the master. For every assigned node 
you need one entry. 
Subindex 0 has the value 127. Every other Subindex corresponds with the 
Node-ID of the node. 
 
Byte Bit Description 
Byte 0 Bit 0 0: Node with this ID is not a slave 

1: Node with this ID is a slave. After configuration (with 
Configuration Manager) the Node will be set to state 
Operational. 

 Bit 1 0: On Error Control Event or other detection of a 
booting slave inform the application. 
1: On Error Control Event or other detection of a 
booting slave inform the application and automatically 
start Error Control service. 

 Bit 2 0: On Error Control Event or other detection of a 
booting slave do NOT automatically configure and 
start the slave. 
1: On Error Control Event or other detection of a 
booting slave do start the process   Start Boot Slave. 

 Bit 3..7 Reserved by CiA, always 0 
Byte 1  8 Bit Value for the RetryFactor 
Byte 2,3  16 Bit Value for the GuardTime 

NMT Start-up 

Slave Assignment 
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Index Sub- 

Index 
Name Type Attr. Map. Default value Meaning 

0x1F82 0x00 RequestNMT Unsigned8 rw N 0x00000000  
 
 
If a totally automatic start of the stack is not wanted, the functionalities: 
• Status change 
• Start of the guarding 
• Configuration via CMT 
can be also executed at request for every node. The request always 
happens via objects in the object directory.  
The switch of the communication state of all nodes in the network (including 
the local slaves) happens via the entry 1F82h in the local object directory: 
 
Subindex 0 has the value 128. 
Subindex x (with x=1 ... 127): Initiates the NMT service for nodes with   
    Node ID x. 
Subindex 128: Initiates NMT service for all nodes. 
 
At write access, the wanted state is given as value.  
 
State Value 
Prepared 4 
Operational 5 
ResetNode 6 
ResetCommunication 7 
PreOperational 127 

 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x1F83 0x00 RequestGuarding Unsigned32 rw N 0x00000000  
 
Subindex 0 has the value 128. 
Subindex x (with x=1..127): Initiates guarding for the slave with Node ID x. 
 
Value Write Access Read Access 

1 Start Guarding Slave actually is guarded 
0 Stop Guarding Slave actually is not guarded  

 
Subindex 128: Request Start/Stop Guarding for all nodes.  

Request NMT 

Request Guarding 
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Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x6000 0x00 8bit digital 
input block 

Unsigned8 ro N 0x01 Number of available digital 
8bit input blocks 
 

 0x01 1. input 
block 

Unsigned8 ro Y  1. digital input block 

 ... ... ... ... ... ... ... 
 0x40 64. input 

block 
Unsigned8 ro Y  64. digital input block 

 

 
Index Sub- 

Index 
Name Type Attr. Map. Default value Meaning 

0x6100 0x00 16bit digital 
input block 

Unsigned8 ro N depending on 
the fitted 
components  

Number of available digital 
16bit input blocks 
 

 0x01 1. input 
block 

Unsigned16 ro N  1. digital input block 

 ... ... ... ... ... ... ... 
 0x20 32. input 

block 
Unsigned16 ro N  32. digital input block 

 

 
Index Sub- 

index 
Name Type Attr. Map. Default value Meaning 

0x6120 0x00 32bit digital 
input block 

Unsigned8 ro N depending on 
the compo-
nents fitted 

Number of available digital 
32bit input blocks 
 

 0x01 1. input 
block 

Unsigned32 ro N  1. digital input block 

 ... ... ... ... ... ... ... 
 0x10 16. input 

block 
Unsigned32 ro N  16. digital input block 

 

8bit Digital inputs 

16bit Digital inputs 

32bit Digital inputs 
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Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x6200 0x00 8bit digital 
output block 

Unsigned8 ro N 0x01 Number of available digital 
8bit output blocks 
 

 0x01 1. output 
block 

Unsigned8 rw Y  1. digital output block 

 ... ... ... ... ... ... ... 
 0x40 64. output 

block 
Unsigned8 rw Y  64. digital output block 

 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x6300 0x00 16bit digital 
input block 

Unsigned8 ro N Depending on 
the compo-
nents fitted 

Number of available digital 
16bit output blocks 
 

 0x01 1. output 
block 

Unsigned16 rw N  1. digital output block 

 ... ... ... ... ... ... ... 
 0x20 32. output 

block 
Unsigned16 rw N  32. digital output block 

 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0x6320 0x00 32bit digital 
input block 

Unsigned8 ro N Depending on 
the compo-
nents fitted 

Number of available digital 
32-bit output blocks 
 

 0x01 1. output 
block 

Unsigned32 rw N  1. digital output block 

 ... ... ... ... ... ... ... 
 0x10 16. output 

block 
Unsigned32 rw N  16. digital output block 

 
 
 
 

8bit Digital 
outputs 

16bit Digital 
outputs 

32bit Digital 
outputs 
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Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA040 0x00 8bit digital 
input block 

Unsigned8 ro N 0x01 Number of available digital 
8bit input blocks 
 

 0x01 1. input 
block 

Unsigned8 ro Y  1. digital input block 

 ... ... ... ... ... ... ... 
 0x140 320. input 

block 
Unsigned8 ro Y  320. digital input block 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA100 0x00 16bit digital 
input block 

Unsigned8 ro N depending on 
the fitted 
components  

Number of available digital 
16bit input blocks 
 

 0x01 1. input 
block 

Unsigned16 ro N  1. digital input block 

 ... ... ... ... ... ... ... 
 0xA0 160. input 

block 
Unsigned16 ro N  160. digital input block 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA200 0x00 32bit digital 
input block 

Unsigned8 ro N depending on 
the compo-
nents fitted 

Number of available digital 
32bit input blocks 
 

 0x01 1. input 
block 

Unsigned32 ro N  1. digital input block 

 ... ... ... ... ... ... ... 
 0x50 80. input 

block 
Unsigned32 ro N  80. digital input block 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA440 0x00 64bit digital 
input block 

Unsigned8 ro N depending on 
the compo-
nents fitted 

Number of available digital 
64bit input blocks 
 

 0x01 1. input 
block 

Unsigned32 ro N  1. digital input block 

 ... ... ... ... ... ... ... 
 0x28 40. input 

block 
Unsigned32 ro N  40. digital input block 

 

8bit Network  input variables 

16bit Network  input variables 

32bit Network  input variables 

64bit Network  input variables 
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Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA400 0x00 8bit digital 
output block 

Unsigned8 ro N 0x01 Number of available digital 
8bit output blocks 
 

 0x01 1. output 
block 

Unsigned8 rw Y  1. digital output block 

 ... ... ... ... ... ... ... 
 0x140 320. output 

block 
Unsigned8 rw Y  320. digital output block 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA580 0x00 16bit digital 
input block 

Unsigned8 ro N Depending on 
the compo-
nents fitted 

Number of available digital 
16bit output blocks 
 

 0x01 1. output 
block 

Unsigned16 rw N  1. digital output block 

 ... ... ... ... ... ... ... 
 0xA0 160. output 

block 
Unsigned16 rw N  160. digital output block 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA680 0x00 32bit digital 
input block 

Unsigned8 ro N Depending on 
the compo-
nents fitted 

Number of available digital 
32-bit output blocks 
 

 0x01 1. output 
block 

Unsigned32 rw N  1. digital output block 

 ... ... ... ... ... ... ... 
 0x50 80. output 

block 
Unsigned32 rw N  80. digital output block 

 
 

Index Sub- 
index 

Name Type Attr. Map. Default value Meaning 

0xA8C
0 

0x00 64bit digital 
input block 

Unsigned8 ro N Depending on 
the compo-
nents fitted 

Number of available digital 
64bit output blocks 
 

 0x01 1. output 
block 

Unsigned32 rw N  1. digital output block 

 ... ... ... ... ... ... ... 
 0x50 40. output 

block 
Unsigned32 rw N  40. digital output block 

 

 
 

8bit Network  output variables 

16bit Network  output variables 

32bit Network  output variables 

64bit Network  output variables 
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